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CAN BUS ANALYZER
USER’S GUIDE
Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
CAN Bus Analyzer. Items discussed in this chapter include:
• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Website
• Product Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT 
This user’s guide describes how to use the CAN Bus Analyzer as a development tool 
to emulate and debug firmware on a target board. The topics discussed in this preface 
include:
• Chapter 1. “Introduction”
• Chapter 2. “Installation” 
• Chapter 3. “Using the PC GUI”
• Appendix A. “Error Messages”

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 
Select the Help menu, and then Topics to open a list of available on-line help files.
 2009-2020 Microchip Technology Inc. DS50001848C-page 5
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CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat
File paths c:\mcc18\h
Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-
Bit values 0, 1
Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS50001848C-page 6  2009-2020 Microchip Technology Inc.



Preface
RECOMMENDED READING
This user’s guide describes how to use the CAN Bus Analyzer on a CAN network. The 
following Microchip documents are available on www.microchip.com and are recom-
mended as supplemental reference resources to understand CAN (Controller Area 
Network) more thoroughly.
AN713, Controller Area Network (CAN) Basics (DS00713)
This application note describes the basics and key features of the CAN protocol. 
AN228, A CAN Physical Layer Discussion (DS00228)
AN754, Understanding Microchip’s CAN Module Bit Timing (DS00754
These application notes discuss the MCP2551 CAN transceiver and how it fits within 
the ISO 11898 specification. ISO 11898 specifies the physical layer to ensure 
compatibility between CAN transceivers.
CAN Design Center
Visit the CAN design center on Microchip’s website (www.microchip.com/CAN) for 
information on the latest product information and new application notes.

THE MICROCHIP WEBSITE
Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

PRODUCT CHANGE NOTIFICATION SERVICE
Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.
To register, access the Microchip website at www.microchip.com, click on Product 
Change Notification and follow the registration instructions.
 2009-2020 Microchip Technology Inc. DS50001848C-page 7
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CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or FAE for support. Local 
sales offices are also available to help customers. A listing of sales offices and 
locations is included in the back of this document.
Technical support is available through the website at: http://support.microchip.com.

DOCUMENT REVISION HISTORY

Revision A (July 2009)
• Initial Release of this Document.

Revision B (October 2011)
• Updated Sections 1.1, 1.3, 1.4 and 2.3.2. Updated the figures in Chapter 3, and 

updated Sections 3.2, 3.8 and 3.9.

Revision C (November 2020)
• Removed Sections 3.4, 3.5, 3.6 and 3.8.
• Updated Chapter 1. “Introduction”, Section 1.5 “CAN Bus Analyzer 

Software” and Section 3.2 “Trace Feature”.
• Typographical edits throughout document.
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USER’S GUIDE
Chapter 1.  Introduction
1.1 INTRODUCTION
The CAN Bus Analyzer tool is intended to be a simple-to-use, low-cost CAN Bus 
monitor, which can be used to develop and debug a high-speed CAN network. The tool 
features a broad range of functions, which allow it to be used across various market 
segments, including automotive, marine, industrial and medical.
The CAN Bus Analyzer tool supports CAN 2.0b and ISO 11898-2 (high-speed CAN with 
transmission rates of up to 1 Mbit/s). The tool can be connected to the CAN network 
using the DB9 connector or through a screw terminal interface.
The CAN Bus Analyzer has the standard functionality expected in an industry tool, such 
as trace and transmit windows. All of these features make it a very versatile tool, 
allowing fast and simple debugging in any high-speed CAN network.
The chapter contains the following information:
• Can Bus Analyzer Kit Contents
• Overview of the CAN Bus Analyzer
• CAN Bus Analyzer Hardware Features 
• CAN Bus Analyzer Software

1.2 CAN BUS ANALYZER KIT CONTENTS
1. CAN Bus Analyzer Hardware
2. CAN Bus Analyzer Software
3. CAN Bus Analyzer software CD, which includes three components:

• Firmware for the PIC18F2550 (Hex File)
• Firmware for the PIC18F2680 (Hex File)
• The CAN Bus Analyzer PC Graphical User Interface (GUI)

4. USB mini-cable to connect the CAN Bus Analyzer to the PC

1.3 OVERVIEW OF THE CAN BUS ANALYZER
The CAN Bus Analyzer provides similar features available in a high-end CAN network 
analyzer tool at a fraction of the cost. The CAN Bus Analyzer tool can be used to 
monitor and debug a CAN network with an easy-to-use Graphical User Interface. The 
tool allows the user to view and log received and transmitted messages from the CAN 
Bus. The user is also able to transmit single or periodic CAN messages onto a CAN 
Bus, which is useful during development or testing of a CAN network.
Using this CAN Bus Analyzer tool has many advantages over the traditional debugging 
methods embedded engineers typically rely on. For example, the tool trace window will 
show the user the received and transmitted CAN messages in an easy to read format 
(ID, DLC, data bytes and timestamp).
 2009-2020 Microchip Technology Inc. DS50001848C-page 9
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1.4 CAN BUS ANALYZER HARDWARE FEATURES 
The CAN Bus Analyzer hardware is a compact tool that includes the following hardware 
features. Refer to Section 1.5 “CAN Bus Analyzer Software” for more information 
about the software features.

FIGURE 1-1: CAN BUS ANALYZER

• Mini-USB Connector
This connector provides the CAN Bus Analyzer a communication medium to the 
PC, but it can also provide a power supply if the external power supply is not 
plugged into the CAN Bus Analyzer.

• 9-24 Volt Power Supply Connector
When powered by the external power supply, the tool can be set up to disconnect 
from the PC to act as a periodic transmitter for CAN Bus messages. The tool can 
also be set up to send out a pulse upon reception of certain CAN messages, which 
is useful during development or debugging issues with an oscilloscope.

• DB9 Connector for the CAN Bus
• Termination Resistor (software controllable)

The user can turn on or off the 120 Ohm CAN Bus termination through the PC GUI.
• Status LEDs

Displays the USB status.
• Trigger LED

Future functionality.
• CAN Traffic LEDs

Shows the actual RX CAN Bus traffic from the high-speed transceiver.
Shows the actual TX CAN Bus traffic from the high-speed transceiver.

• CAN Bus Error LED
Shows the Error Active (Green), Error Passive (Yellow), Bus Off (Red) state of the 
CAN Bus Analyzer.

• Direct Access to the CANH and CANL Pins through a Screw Terminal
Allows the user access to the CAN Bus for connecting an oscilloscope without 
having to modify the CAN Bus wire harness.

• Direct Access to the CAN TX and CAN RX Pins through a Screw Terminal
Allows the user access to the digital side of the CAN Bus transceiver.
DS50001848C-page 10  2009-2020 Microchip Technology Inc.



Introduction


 2009-2020 M

icrochip Technology Inc.
D

S50001848C
-page 11

FIG

_RES

VBB

ANRXD
ANTXD

Vcc

Vcc

C
A

N
 B

us
C

A
N

 B
us

Note: np = not populated

5
9
4
8
3
7
2
6
1

P2P2
R16

1K

R16

1K

C16C16

4.7 pF

1 2
E1E1

C19C19

.01 μF

IN 1

G
N

D

-5.0V-5.0V

R24

56

R24

56

TP6TP6

D8S1G D8S1G

Q2

FD
N

352AP

Q2

FD
N

352AP

D9

P6SMB43AT3G

D9

P6SMB43AT3G

R28
100K

R28
100K

R27

33K

R27

33K

2
3
1

P3P3

Q3

FD
N

35
2A

P

Q3

FD
N

35
2A

P

4.7pF
C15

4.7pF
C14

4.7 pF
C13
tbd
C13
tbd

TP4TP4

1
2
3
4
5
6

JP1JP1

R26
0

TP3TP3

H 7L 6

F 5
S 8

C20C20

10 μF

2

3

1

D6
NUP2105L

D6
NUP2105L

5656

R25
URE 1-2: CAN BUS ANALYZER SCHEMATIC

CAN

B
U

S
Y

V

V

C
C

Vcc

Vcc

VccVcc

Vcc

Vcc

Vcc

Vcc

Vcc

Vcc

V

V

V

Vcc

V

Triggers In/Out

PI
C

ki
t 2

PIC
kit™

 2

Not Suspend

USB Busy

C
A

N
 R

xd

C
A

N
 T

xd

Trigger Status

CAN Bus Status

Ext Pwr On

IOVL12 IOVCC1 13
3-State8

V
1

V
cc

14

U4-1

MAX3378E

U4-1

MAX3378E
R30 470R30 470

LED5

Y
el

 L
E

D

LED5

Y
el

 L
E

D

C3C3
27 pF

D2 S1GD2 S1G

D7
S1G
D7
S1GR31 470R31 470

R33
4.7K
R33
4.7K

LED4

Y
el

 L
E

D

LED4

Y
el

 L
E

D

OUT3

2

REG1LM2937REG1LM2937

C2 27 pF

Y2Y2
10 MHz

Y1Y1

12 MHz

1
TP1TP1

R22

470

R22

470

R32 470R32 470

LED9
Blue LED

LED9
Blue LED

D3 1N4148WSD3 1N4148WS

1 TP9TP9

D1 S1GD1 S1G

R1810K R1810K

R19

1K

R19

1K

R17

470

1
2
3
4
5
6

J1J1

C18C18
10.0 μF

R5

np

R5

np

R1 470R1 470

D4
1N4148WS

D4
1N4148WS

R15

470

LED1Yellow LED LED1Yellow LED

R10
10K
R10
10K

R2 470R2 470

R13 4.7K

Q1
FDN352AP

Q1
FDN352AP

1
TP8TP8

R8 10KR8 10K

1 TP2TP2
R9 1KR9 1K

R3
100K
R3
100K

LED8

WP3VEGW

LED8

WP3VEGW

LED3
WP3VEGW
LED3
WP3VEGW

R29 470R29 470

R21

470

R21

470

1
TP7TP7

MCLR/V /RE31

OSC1/CLKIN/RA79

OSC2/CLKOUT/RA610

G
N

D
8

G
N

D
19

V
20

RA0/AN02
RA1/AN13
RA2/AN2/V -4
RA3/AN3/V +5
RA4/T0CLI6
RA5/AN4/SS/LVDIN7

RB0/INT0/AN10 21
RB1/INT1/AN8 22

RB2/CANTX 23
RB3/CANRX 24

RB4/AN9 25
RB5 26
RB6 27
RB7 28

RC0/T1OSO/T13CKI 11
RC1/T1OSI 12
RC2/CCP1 13

RC3/SCK/SCL 14
RC4/SDI/SDA 15

RC5/SDO 16
RC6/TX/CK 17
RC7/RX/DT 18

U2

PIC18F2680

U2

PIC18F2680

MCLR/V /RE3 1

OSC1/CLKIN 9

OSC2/CLKOUT/RA6 10

G
N

D
8

G
N

D
19

V
20

RA0/AN0 2
RA1/AN1 3

RA2/AN2/V -/CV 4
RA3/AN3/V + 5

RA4/T0CLI/C1OUT/RCV 6
RA5/AN4/SS/LVDINC2OUT 7

RB0/INT0/AN12/FLT0/SDI/SDA21
RB1/INT1/AN10/SCK/SCL22
RB2/AN8/INT2/VMO23
RB3/AN9/CCP2/VPO24
RB4/AN11/KBI025
RB5/KBI1/PGM26
RB6KBI2/PGC27
RB7/KBI3/PGD28

RC0/T1OSO/T13CKI11
RC1/T1OSI/CCP2/UOE12
RC2/CCP113
V14
RC4/D-/VM15
RC5/D+/VP16
RC6/TX/CK17
RC7/RX/DT/SDO18

U1

PIC18F2550

U1

PIC18F2550

R6 0R6 0

R20 1KR20 1KC8C8

0.1 μF D5 NSR0620P2T5GD5 NSR0620P2T5G

C4
0.1 μF

LED7

WP3VEGW

LED7

WP3VEGW

R7 0R7 0

R11
0
R11
0 R12 20KR12 20K

C17
.01 μF

IOVL23 IOVCC2 12
U5-2U5-2

1
2
3
4
5
6

J2J2

C1C1
0.1 μF

S1S1

LED6
Purple LED

LED6
Purple LED

C7C7
470 nF

R23

np

R23

np

1 TP5TP51
2
3
4

J3J3

LED2Green LED LED2Green LED

R4
1K
R4
1K

C10 22 pF

V 1
D- 2
D+ 3
nc 4

GND 5

P1

USB Mini-B

P1

USB Mini-B

C5C5

0.1 μF

C9 0.1 μF

C11 22 pF

CAN

GND2

CAN

Vcc3

TXD1 RXD4

RE
R

U3

MCP2551

U3

MCP2551

S2S2

C12C12
0.1 μF

C6
0.1 μF

1 TP10TP10

R14 100KR14 100K



CAN Bus Analyzer User’s Guide
1.5 CAN BUS ANALYZER SOFTWARE
The CAN Bus Analyzer comes with two firmware Hex files and PC software which 
provide the user with a graphical interface to configure the tool, and analyze a CAN 
network. It has the following software tool features:
1. Trace: Monitor the CAN Bus traffic.
2. Transmit: Transmit single-shot, periodic or periodic messages with a limited 

repeat onto the CAN Bus.
3. Log File Setup: Save CAN Bus traffic.
4. Hardware Setup: Configure the CAN Bus Analyzer for the CAN network.
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Chapter 2.  Installation
2.1 INTRODUCTION
The following chapter describes the procedures for installing the CAN Bus Analyzer 
hardware and software.
This chapter contains the following information:
• Software Installation 
• Hardware Installation

2.2 SOFTWARE INSTALLATION 

2.2.1 Installing the GUI
Install .NET Framework Version 3.5 before installing the CAN Bus Analyzer.
1. Run “CANAnalyzer_verXYZ.exe”, where “XYZ” is the version number of the 

software. By default, this will install the files to: C:\Program Files\
Microchip Technology Inc\CANAnalyzer_verXYZ.

2. Run the setup.exe from folder: C:\Program Files\Microchip 
Technology Inc\CANAnalyzer_verXYZ\GUI.

3. The setup will create a shortcut in the Programs menu under “Microchip 
Technology Inc” as Microchip CAN Tool ver XYZ. 

4. If the CAN Bus Analyzer PC software is being upgraded to a newer version, the 
firmware should be updated to match the revision level of the PC software. When 
updating the firmware, ensure that the Hex files are programmed into their 
respective PIC18F microcontrollers on the CAN Bus Analyzer hardware.

2.2.2 Upgrading the Firmware
If upgrading the firmware in the CAN Bus Analyzer, the user will need to import the Hex 
files into MBLAB® IDE and program the PIC® MCUs. When programming the 
PIC18F2680, the user may power the CAN Bus Analyzer by an external power supply 
or by the mini-USB cable. When programming the PIC18F550, the user needs to power 
the CAN Bus Analyzer by an external power supply. Additionally, when programming 
Hex files into PIC MCUs, it is recommended to check the firmware version from the 
GUI. This can be done by clicking on the Help>About menu option.
 2009-2020 Microchip Technology Inc. DS50001848C-page 13
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2.3 HARDWARE INSTALLATION

2.3.1 System Requirements
• Windows® XP
• .NET Framework Version 3.5
• USB Serial Port

2.3.2 Power Requirements
• A power supply (9 to 24-Volt) is needed when operating without the PC and when 

updating firmware in the USB PIC MCU
• The CAN Bus Analyzer tool can also be powered using the USB port

2.3.3 Cable Requirements
• Mini-USB cable – for communicating with the PC software
• The CAN Bus Analyzer tool can be connected to a CAN network using the 

following:
- Via the DB9 connector
- Via screw-in terminals

2.3.4 Connecting the CAN Bus Analyzer to the PC and CAN Bus
1. Connect the CAN Bus Analyzer via the USB connector to the PC. You will be 

prompted to install the USB drivers for the tool. The drivers can be found in this 
location: 
C:\Program Files\Microchip Technology Inc\CANAnalyzer_verXYZ

2. Connect the tool to the CAN network using the DB9 connector or the screw-in 
terminals. Please refer to Figure 2-1 and Figure 2-2 for the DB9 connector, and 
the screw terminals for connecting the network to the tool.

TABLE 2-1: 9-PIN (MALE) D-SUB CAN BUS PINOUT
Pin Number Signal Name Signal Description

1 No Connect N/A
2 CAN_L Dominant Low
3 GND Ground
4 No Connect N/A
5 No Connect N/A
6 GND Ground
7 CAN_H Dominant High
8 No Connect N/A
9 No Connect N/A
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FIGURE 2-1: PINOUT FOR THE DB9 CONNECTOR

FIGURE 2-2: PINOUT FOR THE SCREW-IN TERMINALS

TABLE 2-2: 6-PIN SCREW CONNECTOR PINOUT
Pin Number Signal Names Signal Description

1 Vcc PIC® MCU Power Supply
2 CAN_L Dominant Low
3 CAN_H Dominant High
4 RXD CAN Digital Signal from Transceiver
5 TXD CAN Digital Signal from PIC18F2680
6 GND Ground

JP1VCC

CANL
CANH

RXD
TXD

1
2
3
4
5
6
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Chapter 3.  Using the PC GUI
Once the hardware is connected and the software is installed, open the PC GUI using 
the shortcut in the Programs Menu under “Microchip Technology Inc”, labeled as 
‘Microchip CAN Tool ver XYZ’. Figure 3-1 is a screen shot of the default view for the 
CAN Bus Analyzer.

FIGURE 3-1: CAN BUS ANALYZER DEFAULT VIEW

3.1 GETTING STARTED WITH A QUICK SETUP
The following are setup steps to quickly start transmitting and receiving on the CAN 
Bus. For more details, refer to the individual sections for the different PC GUI features.
1. Connect the CAN Bus Analyzer to the PC with the mini-USB cable.
2. Open the CAN Bus Analyzer PC GUI.
3. Open the Hardware Setup and select the CAN Bus bit rate on the CAN Bus.
4. Connect the CAN Bus Analyzer to the CAN Bus.
5. Open the Trace window.
6. Open the Transmit window.
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3.2 TRACE FEATURE
There are two types of Trace windows: Fixed and Rolling. To activate either Trace 
window, select the option from the main Tools menu.

FIGURE 3-2: FIXED TRACE WINDOW

FIGURE 3-3: ROLLING TRACE WINDOW

The Trace window displays the CAN Bus traffic in a readable form. This window will list 
the ID (Extended is signified with a preceding ‘x’ or Standard), DLC, DATA Bytes, the 
Timestamp and the time difference from the last CAN Bus message on the bus. The 
Rolling Trace window will show the CAN messages sequentially as they appear on the 
CAN Bus. The time delta between messages will be based on the last received 
message, regardless of THE CAN ID.
The Fixed Trace window will show the CAN messages in a fixed position on the Trace 
window. The message will still be updated, but the time delta between messages will 
be based on the previous message with the same CAN ID. 
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3.3 TRANSMIT FEATURE
To activate the Transmit window, select “TRANSMIT” from the main Tools menu.

FIGURE 3-4: TRANSMIT WINDOW

The Transmit window allows the user to interact with other nodes on the CAN Bus by 
transmitting messages. The user is able to enter any ID (Extended or Standard), DLC 
or DATA bytes combination for single message transmittal. The Transmit window also 
allows the user to transmit a maximum of nine separate and unique messages, either 
periodically, or periodically with a limited “Repeat” mode. When using the limited 
Repeat mode, the message will be sent out at the periodic rate for a number of “repeat” 
times.

3.3.1 Steps to Transmit a Single-Shot Message
1. Populate the CAN message fields, which include the ID, DLC and DATA.
2. Populate the Periodic and Repeat fields with “0”.
3. Click on the Send button for that row.

3.3.2 Steps to Transmit a Periodic Message
1. Populate the CAN message fields, which include the ID, DLC and DATA.
2. Populate the Periodic field (50 ms to 5000 ms).
3. Populate the Repeat field with “0” (which translates to “repeat forever”).
4. Click on the Send button for that row.

3.3.3 Steps to Transmit a Periodic Message with Limited Repeats
1. Populate the CAN message fields, which include the ID, DLC and DATA.
2. Populate the Periodic field (50 ms to 5000 ms).
3. Populate the Repeat field (with a value from 1 to 10).
4. Click on the Send button for that row.
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3.4 HARDWARE SETUP FEATURE
To activate the Hardware Setup window, select “HARDWARE SETUP” from the main 
Tools menu.

FIGURE 3-5: HARDWARE SETUP WINDOW

The Hardware Setup window allows the user to set up the CAN Bus Analyzer for com-
munication on the CAN Bus. This feature also gives the user the ability to quickly test 
the hardware on the CAN Bus Analyzer.
To set up the tool to communicate on the CAN Bus:
1. Select the CAN bit rate from the drop-down combo box.
2. Click the Set button. Confirm that the bit rate has changed by viewing the bit rate 

setting on the bottom of the main CAN Bus Analyzer window.
3. If the CAN Bus needs the termination resistor active, then turn it on by clicking 

the Turn On button for the Bus Termination.
Test the CAN Bus Analyzer hardware:
1. Ensure that the CAN Bus Analyzer is connected. You can confirm this by viewing 

the tool connection status on the status strip on the bottom of the main CAN Bus 
Analyzer window.

2. To confirm that the communication is working between the USB PIC® MCU and 
the CAN PIC MCU, click on the Help->About main menu option to view the 
version numbers of the firmware loaded into each PIC MCU.
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Appendix A. Error Messages
In this section, the various “pop-up” errors that are found in the GUI will be discussed 
in detail as to why they may occur, and the possible solutions for correcting the errors.

TABLE A-1: ERROR MESSAGES

Error 
Number Error Possible Solution

1.00.x Trouble reading the USB firmware version Unplug/plug the tool into the PC. Also make sure that the 
PIC18F2550 is programmed with the proper Hex file.

2.00.x Trouble reading the CAN firmware version Unplug/plug the tool into the PC. Also make sure that the 
PIC18F2680 is programmed with the proper Hex file.

3.00.x ID field is empty The value in the ID field can not be empty for a message that 
a user is requesting to be transmitted. Enter a valid value.

3.10.x DLC field is empty The value in the DLC field can not be empty for a message 
that a user is requesting to be transmitted. Enter a valid 
value.

3.20.x DATA field is empty The value in the DATA field can not be empty for a message 
that a user is requesting to be transmitted. Enter a valid 
value. Remember, the DLC value drives how many data 
bytes will be sent.

3.30.x PERIOD field is empty The value in the PERIOD field can not be empty for a 
message that a user is requesting to be transmitted. Enter a 
valid value.

3.40.x REPEAT field is empty The value in the REPEAT field can not be empty for a 
message that a user is requesting to be transmitted. Enter a 
valid value.

4.00.x Enter the Extended ID within the following 
range (0x-1FFFFFFFx)

Enter a valid ID into the TEXT field. The tool is expecting a 
hexidecimal value for an Extended ID in the range of 
“0x-1FFFFFFFx”. When entering an Extended ID, make sure 
to append ‘x’ onto the ID.

4.02.x Enter the Extended ID within the following 
range (0x-536870911x)

Enter a valid ID into the TEXT field. The tool is expecting a 
decimal value for an Extended ID in the range of 
“0x-536870911x”. When entering an Extended ID, make sure 
to append ‘x’ onto the ID.

4.04.x Enter the Standard ID within the following 
range (0-7FF)

Enter a valid ID into the TEXT field. The tool is expecting a 
hexidecimal value for a Standard ID in the range of “0-7FF”. 
When entering a Standard ID, make sure to append ‘x’ onto 
the ID.

4.06.x Enter the Standard ID within the following 
range (0-2047)

Enter a valid ID into the TEXT field. The tool is expecting a 
decimal value for a Standard ID in the range of “0-2048”. 
When entering a Standard ID, make sure to append ‘x’ onto 
the ID.

4.10.x Enter DLC within the following range (0-8) Enter a valid DLC into the TEXT field. The tool is expecting a 
value in the range of “0-8”.

4.20.x Enter DATA within the following range 
(0-FF)

Enter valid data into the TEXT field. The tool is expecting a 
hexidecimal value in the range of “0-FF”.
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4.25.x Enter DATA within the following range 
(0-255)

Enter valid data into the TEXT field. The tool is expecting a 
decimal value in the range of “0-255”.

4.30.x Enter a valid PERIOD within the following 
range (100-5000)\nOr (0) for a one-shot 
message

Enter a valid period into the TEXT field. The tool is expecting 
a decimal value in the range of “0 or 100-5000”.

4.40.x Enter a valid REPEAT within the following 
range (1-99)\nOr (0) for a one-shot 
message

Enter a valid repeat into the TEXT field. The tool is expecting 
a decimal value in the range of “0-99”.

4.70.x Unknown error caused by user input Check that the TEXT field only has no special characters or 
spaces.

4.75.x Required input for CAN Message is empty Check that the ID, DLC, DATA, PERIOD and REPEAT fields 
contain valid data.

5.00.x Reserved for Message Received errors Reserved for Message Received errors.
6.00.x Unable to Log Data Tool is unable to write CAN traffic to Log File. Possible cause 

may be that the drive is either full, write-protected or does not 
exist.

TABLE A-1: ERROR MESSAGES (CONTINUED)

Error 
Number Error Possible Solution
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